Preface

The EE 213-Electric Circuits Lab is an essential component of the Electrical
Engineering program. The lab is designed to help students understand the basic
principles of electric circuits and to give them an insight into the design,
simulation and hardware implementation of electric circuits. The main objective
IS to provide hands-on experience for the students so they are able to put
theoretical concepts into practice.

The experiments include both software circuit simulations and hardware-based
measurements with actual electrical components. Computer simulation is
stressed as a key analysis tool in engineering design. Multisim Electronics
Workbench software is used for simulation of electric circuits. Hardware
experimentation with components and laboratory equipment is always important
for acquiring the necessary hands-on practical skills in engineering education.

The present manual includes eleven experiments that cover topics taught in the
two Electric Circuits courses EE211 and EE213. The manual also includes
appendices on components color codes and general laboratory regulations and
safety rules.
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Experiment 1
Introduction to Electrical Circuits Simulation and Testing

Simulation is a mathematical way of emulating the behavior of a real world system. With
simulation modeling, we can determine a circuit’s performance without physically
constructing the circuit or using actual test instruments. Multisim Workbench is a complete
system design tool that offers a very large component database, schematic entry, full
analog/digital SPICE simulation, etc. It also offers a single easy-to-use graphical user
interface for all design needs.

Introduction

Go to Start-=>Programs->Multisim and click on Multisim. This will open the main window
as shown in Fig. 1. In Fig. 1 important toolbars and menu are labeled. In addition to the
toolbars shown in Fig. 1, there may be other toolbars appearing on your screen so concentrate
on the labeled items in Fig. 1 at this time.

You can always open and close a toolbar from the Main Menu. For example, if you want to
open or close (select/unselect) the Design Toolbar, select View->»Toolbars=>Design. If any
toolbar does not appear on your screen then use the above procedure to make it appear.

Most of the analysis can be performed by turning on/off the simulate switch. If the simulate
switch shown in Fig. 1 does not appear on your screen then select View->Show Simulate
Switch in the Main Menu. This will open the Simulation Switch. Always, remember to save
your file to keep the changes you made in the circuit by selecting File->Save.
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Figure 1. Main Window of Multisim Simulation Software
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We will now try to learn about Multisim simulation techniques by solving a simple example.

Example

Build the circuit shown in Fig. 2 using Multisim Electronics Workbench.
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Figure 2: Circuit for Multisim Simulation

STEP A: Placing the Components

1. Place a Battery (DC Source)

a. Bring a DC source into the Multisim workspace:

Open the Multisim program if it is not already open. In the Component Toolbar,
select the Sources icon (refer to Fig. 1 to find the Component Toolbar). This will
open another window with several types of DC sources and other components as
shown below in Fig. 3. Click on “DC Voltage Source” in this new window.
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Figure 3: Selection of DC Voltage Source in Multisim

Now bring your cursor into the workspace area and notice the change in the shape of

the cursor to
AT I

Click at any point in the workspace. This will show the voltage source as == Az
T
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b. Change the value and name of the voltage source:

Double-click on the voltage source that you just placed in the workspace, and a new
window with the name Battery will appear, as shown in Fig. 4. Select Value in the
Battery menu, if it is not already selected. Change the value from 12 to 30. Keep the
unit as Volts in this menu. Now select Label in this menu and change the Reference
ID to Vs. Click on OK.

Battery E|
Label ] Display ¥alue ]Analysis Setup] Fault I
Yaltage [V] W 3:

[~ Tolerance

ak | Cancel | Info | Help |

Figure 4: Battery Window for setup of DC voltage source

2. Place a Resistor:

a. Bring a resistor into the Multisim workspace:

In the Component toolbar, select the Basic icon as shown. This will open another
window with several basic components as shown below in Fig. 5.
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Component Toolbar
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Select the
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Figure 5: Selection of Resistor in Multisim

Click on “Resistor.” This will open the Browser-Basic window, as shown in Fig. 6.
Scroll through the Component List, select 30 kOhm, and click OK. The cursor shape

will change again. Click in the workspace and this will show the resistor = &1

as: T
. 30kohm .
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Tip To speed up your scroll through the Browser’s Component List, simply type the
first few characters of the component’s name. For example, type 30k to move
directly to the area of the 30 kOhm list.
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Figure 6: Setup window for Resistor values

b. Change the name of the resistor:

Double-click on the resistor, and a new window with the name Resistor will open as
shown in Fig. 7. Select Label from the menu of this window. Change the Reference
ID to Ry (if it is not already) and press OK. This will change the name of the resistor
to R;.
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Figure 7: Battery Window for Label of Resistor
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d. Add another resistor R,

Place resistor R, of value 20 kQ in the workspace through the same procedure.

e. Rotate the resistor:

Select resistor ‘Ry’ and press Ctrl-R to rotate the resistor or select Edit=>90
Clockwise from the Main Menu. This will make the resistor vertical. Labels and
values of all the components can be dragged individually. Drag the label ‘R’ and
value ‘20 kOhm’ individually to put them in a suitable place.

3. Place Ground:

In the Component Toolbar, select the Sources icon. Now click on the Ground icon in the
new window as shown in Fig. 8. Click in the workspace to show the Ground symbol as
below

Select the Sources Icon L
from Component Toolbar g

Select
Ground

<
k3
E3

SRl
e

Figure 8: Selection of Ground in Multisim

STEP B: Connecting the Components

1. Arrange the components properly:

Arrange the components according to the circuit given in Fig. 2. You can select and drag
the component to any place in the workspace. Select the components and drag them one
by one to their proper places as shown in Fig. 9.

R1

30KQ

R2

\\}—

Figure 9: Arranging the Components in proper order
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2. Show Grid in the workspace:

You may show a grid for ease of drawing the connections. Select View->Grid Visible in
the Main Menu if it is not already visible.

3. Connect DC Voltage Source “Vs” to “R;”:

Bring the cursor close to the upper pin of “Vs”; the cursor shape will change to a plus
sign. Click and move a little upward. A wire appears, attached to the cursor. Click again
at a small distance above the “Vs” source. Notice that the line will change direction.
Control the flow of the wire by clicking on points as you drag. Each click fixes the wire
to that point as shown in Fig. 10. In this way, when the cursor reaches the pin of R; click
again and this will connect “Vs” to “R;”. Notice that a node number is automatically
given.

L R1 ..
The mouse button == e
was clicked at this 3 Z0kabim
location I
. R T
Toagy L

Figure 10: Manual connection of components

4. Connect “R;” to “R,”:
Connect R; to R, using the same procedure.

5. Making use of the Junction to connect the Ground:

In a similar manner, connect the ground with Vs and R,. Notice that a small black circle
appears just above the ground, this is called the junction. When two or more components
are connected at one point, a junction is created. A junction can also be placed manually
by pressing Ctrl+J or selecting Edit->Place Junction. This can be used to control the
connection points manually. Also notice that the ground node is automatically given node
number 0. Do not alter it.

This completes the connection and the complete circuit is shown in Fig. 11.

R1

30KQ

" 20KQ R2

Figure 11: Complete Circuit in Multisim
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Wire paths can be modified using drag points. Click on a wire. A number of drag points
will appear on the wire as shown in Fig. 12. Click any of these and drag to modify the
shape. You can also add or remove drag points to give you even more control over the
wire shape. To add or remove drag points, press CTRL and click on the location where
you want the drag point added or removed.

Drag Points

Figure 12: Drag points for connecting wire

STEP C: Placing Multimeter or Voltmeter in parallel to measure voltage

1. To connect a Multimeter:

a. Select View->Toolbar-> Instruments. The Instruments toolbar will open as shown in
Fig. 13.
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Figure 13: Instruments Toolbar

b. Click on the Multimeter icon. Now click in the workspace to place the Multimeter.
Drag it and place it near resistor Ry as shown in Fig. 14. Make a connection from the
‘+’ terminal of the Multimeter to the left pin of R; and from the ‘-’ terminal to the
right pin of R;. Note that the reversal of + and — terminals will give opposite readings.
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Figure 14: Multimeter connection for voltage measurement
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c. Set the Multimeter to measure DC voltage:

Double-click on Multimeter to open the properties window shown in Fig. 15. Select
‘V’ to measure voltage. Select the DC wave shape. (Notice that the meter can also
measure current ‘A’ and resistance ‘C2’. It can measure AC as well as DC values.
Leave the window open for viewing the measurements.

Multimeter-Xmm2 [X]

Selection for gl | == lg=f= Selection for
AC Measurement s - - DC Measurement

Figure 15: Multimeter properties window

STEP D: Placing a Multimeter or Ammeter in series to measure current

1. Place a second Multimeter in the workspace as we did in Step C. Remove the connection
between R; and R;,. Connect the ‘+’ terminal of the Multimeter towards R; and the ‘-
terminal towards R; as shown in Fig. 16.

2. Set the Multimeter to measure current:
Double click on this Multimeter and select ‘A’ in the Multimeter properties window.
Set the wave shape to DC. If the current flows from 3 to zero, the meter will read
positive.

Figure 16: Multimeter connection for current measurement
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STEP E: Circuit Simulation

1. Save the file.
Select File->Save

2. Show the Simulate Switch, on the workspace.
Select View-> Simulate Switch.

3. If the properties window is not open, double-click the Multimeter. Click to the ‘1’
position (ON) of the simulation switch to start simulation. Results will appear in the
properties window of the Multimeter. Compare your result with those in Fig. 17 and
show them to your instructor.
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Figure 17: Simulation result
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Exercise 1

1. Build the circuit of Fig. 18 in Multisim Electronics Workbench.
2. Connect a voltmeter between nodes ‘a’ and ‘b’.
3. Connect an ammeter for the measurement of Iy.

I b
® °
R, 20kQ
Vln + Rl
— ng 10kQ vé
I -5 30kQ
10V
0 IbO
<_
=
Figure 18

Exercise 2

1. Build the circuit of Fig. 19 in Multisim Electronics Workbench.
2. Simulate the circuit and find iy and iy (magnitude and phase)

‘ .
W lx ly

2

20 2H

20 sin(4t)

Figure 19
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Experiment 2
Electric Circuits Fundamental Laws

Introduction

This experiment covers electrical circuit’s fundamental laws, including Ohm’s law, and
Kirkchoff’s voltage and current laws. It consists of three parts which have to be first carried
out using the Multisim Electronics Workbench software, and then repeated with hardware
components and laboratory equipment. The experiments involve the measurement of
resistance, voltage and current in DC circuits.

PART I: Resistance, Voltage & Current in DC Circuits

Objectives

1. Use of voltmeter & ammeter to measure voltage and current through a resistor
2. Verification of component power rating

Materials

DC power supply

DC 0-20V Voltmeter

DC 0-100mA Ammeter

Multimeter

5V/1IW lamp

Assorted carbon resistors (100 Q, 150 Q, 220 €2, 330Q)

Ammeter

Figure 1. Measuring current and voltage: a lamp connected across a battery
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Procedure

Workbench Simulation

1.

Construct the circuit shown in Fig. 1 on the Multisim Electronics Workbench. Use a
5V, 1W lamp for simulation. (In the Components Toolbar select the Indicator icon;
now find Voltmeter, Ammeter and Lamp in this window).

Set the DC supply voltage to 3V, click the Simulate Switch and verify that the
battery voltage is 3V as measured by the voltmeter. Record the voltage across the
lamp terminals ‘V’ and the current ‘I’ flowing through it in Table 1. Calculate power
dissipation in the lamp using the relationship P=VI, and note it down.

Change the DC supply voltage to 5V. Run the analysis again. Record voltage and
current in Table 1 and calculate power dissipation in the lamp.

Change the DC supply voltage to 7V. Run the analysis and see the effect on the
intensity of light. Record voltage and current in Table 1 and calculate power
dissipation.

Change the DC supply voltage to 8V. Run the analysis and observe the value of the
current; also observe the glow of the lamp. What happened? Explain.

Table 1: Simulation results using Multisim Electronics Workbench

Source Voltage (V) Lamp Voltage (V) Current (A) Power , VI (W)

3

Note: The lamp is rated at 5V, 1W

Question: Why would the lamp be damaged when the voltage goes to 8V? Explain by
comparing power dissipation with its rated value.
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PART Il: Resistance Measurement and Ohm’s Law

Objectives

1. Usage of the Multimeter to measure resistance.

2. Verification of Ohm’s law

Multimeter-XMMIES

| 100.000 Ohm

Figure 2: Measuring resistance Figure 3: Verifying Ohm’s Law

Procedure
Workbench Simulation

1. Build the circuit of Fig. 2 using Multisim Electronics Workbench. Connect a
Multimeter between the terminals of the resistor and set it to read resistance. Select
R1=100Q. Click the Simulation Switch to run the analysis. Record the value of
resistance Ry in Table 3’s Ohmmeter Reading.

2. Build the circuit given in Fig. 3. Set Vs = 10V and R;=100Q. Click Simulation
Switch to run the analysis. Record voltage ‘V;’ across resistor Ry by connecting a
Multimeter in parallel to it. Record the value of current ‘I’ flowing through R; by
connecting another Multimeter in series to R;. Note down the values in Table 3. From
the voltage current readings verify Ohm’s law V1=R; I. Considering the Multimeter
reading as a reference, calculate the % error.

3. Vary the DC supply voltage Vs in steps of 2V and record the current in each case.
Enter your results in Table 4.

4. Plot ‘V’ vs. ‘I’ in the graph of Table 5.
Calculate the resistor value based on the slope of the V-I curve plotted in step 4.

Hardware Experiment

6. Repeat steps 1-5 with the laboratory hardware components.
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Table 3: Resistance Measurement

Ohm’s Law
Ohmmeter Reading
V1 | R:V1/|
Workbench Simulation R=
Hardware Experiment R=
Table 4: V-l measurements
Workbench Hardware
V (Volts) I (mA) V (volts) I (mA)
0 0
2 2
4 4
6 6
8 8
V-1 Plot
12
10
z 8
S
= 6
=
4
2
0
0 20 40 60 30 100 120
Iin mA
Resistance measurement from V-1 slope
e Electronics Workbench experiment R=
e Hardware experiment R=
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Questions

1. Compare the values of resistance obtained with the Ohmmeter and with Ohm’s law (V/I)
in the hardware experiment. Find the percentage error between them with the Ohmmeter
reading as the reference.

2. Comment on your results and observations.
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PART I11: Kirkchoff’s Voltage and Current Laws

Kirkchoff’s Voltage Law (KVL) states that the algebraic sum of all voltages around any
closed path equals zero. Kirchhoff’s Current Law (KCL) states that the algebraic sum of all
the currents at a node is zero (the current entering a node has the opposite sign to the current
leaving the node).

Objectives

1. Voltage and Current measurement in a DC circuit
2. Verification of Kirchhoff’s voltage and current laws.

I I
AB—» R1 B R «— “
AVAVAY o—\\/\
lea 2200 1500
—> A C
Fo— o *—
R4 D Rs3
Ve _— 10V ANN———A\NN
I » 330Q2 100Q <+—
IAD CD
E
°

Figure 4: Resistive circuit diagram

Procedure

1. Construct the circuit shown in Fig. 4 using Multisim Electronics Workbench.
2. Measure the voltages Vag, Visc, Vab, Ve, Vep, and Vac. Enter the values in Table 5.

3. Measure the currents lIag, Icg, lap, lcop and Iga. Enter the values in Table 6. Note the
polarity (sign) of the currents.

4. Calculate the voltages around the following loops ABCEFA, ABDA, BDCB, ABCDA, and
record them in Table 8.
5. Verify KCL by adding currents at nodes A, B, C and D. Enter your results in Table 7.

6. Construct the circuit in Fig. 4 with hardware components. Repeat steps 2-5. Enter your
results in Tables5-8. Compute the percentage errors. Comment on any discrepancy in the
voltage/current experimental and theoretical values
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Table 5: Voltage measurements

Vas Vec Vap Vbc Vep Vac
Simulation
Hardware
% Error
Table 6: Current measurements
laB Ics lap lco (I
Simulation
Hardware
% Error
Table 7: Sum of currents at nodes
A B C D
Simulation
Hardware
Table 8: Voltages around loops
ABCEFA ABDA BDCB ABCDA
Simulation
Hardware
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Experiment 3
Voltage & Current Dividers and Superposition Principle

Introduction

This lab covers two parts:
1. the voltage divider and current divider rules
2. the superposition principle

The lab work is based on the use of Multisim Workbench simulation and hardware-based
circuits to verify the voltage current divider and voltage divider rules.

PART I: Voltage & Current Dividers

For a series circuit the voltage divider rule (VDR), refer to Fig. 1:
e Ry
R,+R,+R,
:LVS 1)
R, +R,+R,
— R3
° R,+R,+R; °

2

For a parallel circuit the current divider rule (CDR), refer to Fig. 2:

R2
|1: IS
R, +R, o)
_ Rl |
> R,+R, °
+ Vi
AVAVAY

WO e D eg e

Rs

Vit

Figure 1: Series circuit Figure 2: Parallel circuit

Objectives

1. To verify the voltage current divider and voltage divider rules.
2. To verify the superposition principle using Multisim Electronics Workbench.
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Materials

DC power supply
Multimeter
Assorted carbon resistors (100 Q, 150 Q, 220 Q, 330€2)

Procedure

Simulation Experiment
1. Build the circuit given in Fig. 3 on Multisim Electronics Workbench.

2. Connect voltmeters, ammeters (or Multimeters) at appropriate positions to measure
voltages and currents shown in Table 1.

3. Disconnect the voltage source. Connect a Multimeter, measure the total resistance and
record the value in Table 1. (Remember: resistance is always measured without any
source connected to the circuit)

4. Repeat steps 2 and 3 for the circuit of Fig. 4 and record the values in Table 2.
Hardware Experiment

5. Build the circuit of Fig. 3 with the hardware components. Take the voltage current
measurements and Req and record them in Table 1. Considering the Workbench
results as the base, compute the percentage errors.

6. Build the circuit of Fig. 4 with the hardwired components. Take the voltage current
measurements and Req and record in Table 2. Considering the Workbench results as
the base, compute the percentage errors.

Figure 3: Series-parallel circuit | Figure 4: Series-parallel circuit 11

Vs =10V, R, = 100Q2, R3 = 150Q2, R4 = 220Q2, Rg = 33002
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Table 1: Simulation and experimental results for Fig. 3

8 I I3 (7 Is le Vo | V3 | Vi | V5 | Vg | Re
Simulation
Hardware

Table 2: Simulation and experimental results for Fig. 4

Is I I3 b | Is le | Vo | Va3 | Va | Vs | V6 | R
Simulation
Hardware
Questions

Refer to Fig. 3 and the results of Table 1:
1. Are R4 and Rg in parallel or in series? Refer to voltage current measurements to
justify your answer.

2. Are Rzand Ry in parallel or in series? Why?

3. Are Vs and Rs in parallel or in series? Why?

4. Is VDR applicable for R; and R4? Why?

5. Is CDR applicable for R4 and Rg? Why?
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6. Isthe parallel combination of R4 and Rg in series or in parallel with R,? Why?

Refer to Fig. 4 and the results obtained in Table 2 and answer the following questions:

7. Are R4 and Rg in parallel or in series? Why?

8. Are Vs and R in parallel or in series? Why?

9. Is VDR applicable for R; and R4? Why?

10. Is CDR applicable for R4 and Rg? Why?
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PART Il: Superposition Principle

If there is more than one source in an electric network, the response (voltage or current) can
be obtained by considering one source at a time. The total response is the algebraic sum of
the individual responses. This is known as the superposition principle. While determining the
responses with a particular source, all other sources have to be deactivated (voltage sources
are shorted and current sources are opened).

Objectives

1. To verify the superposition principle using Multisim Electronics Workbench.
2. To verify superposition with hardwired components.

Materials

Two DC power sources
Multimeter
Assorted carbon resistors (10002, 220Q2, 33002, 1kQ, 1.5kQ)

BNV %,V Vg
VN NV \VV\
1kQ 100Q 3300

+ +

10V CD 2209§ Vv, 1.5kQ§ v, C) 5V

Figure 5: Resistive circuit with two sources

Procedure

Simulation

1. Construct the circuit in Fig. 5 on Multisim Electronics Workbench. Put the meters in
the appropriate places to read the voltages and currents.

2. Run the simulation. Record all the voltages and currents in Table 3. You can use
ammeters for current measurements, voltmeter for voltage measurements or
Multimeter for both.

Note the current directions and voltage polarities shown in Fig. 5.
Remove the 5-V source from the circuit. Replace it with a short circuit.
Run the simulation. Measure the voltages and currents and fill in Table 4.

o o~ w

Put the 5-V source back in the circuit. Remove the 10-V source and replace it with a
short circuit.

7. Run the simulation. Record all the voltages and currents in the circuit. Enter them in
Table 5
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Table 3: Simulation results for voltage and current with both sources

1 kQ 220 Q 100 ©Q 1.5 kQ 330 Q
Voltage
Current
Table 4: Simulation results with the 10-V source only
1kQ 220 Q 100 © 1.5kQ 330 Q
Voltage
Current
Table 5: Simulation results with the 5-V source only
1 kQ 220 Q 100 ©Q 1.5 kQ 330 Q
Voltage
Current

Hardware Experiment

8. Repeat the procedure with hardwired circuit elements. Enter your results below.

Table 6: Experimental results with both sources

1kQ 220 Q 100 ©Q 1.5kQ 330 Q
Voltage
Current
Table 7: Experimental results with 10-V source only
1kQ 220 Q 100 ©Q 1.5kQ 330 Q
Voltage
Current
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Table 8: Experimental results with 5-V source only

1 kQ

220 Q

100 &2

1.5 kQ

330 Q

Voltage

Current

Questions

1. Check for the superposition principle. Write your observations.

2. Compare the simulation and experimental results, and comment on any error causes.

3. Superposition only applies to current and voltage, but not to power. Explain why.
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Experiment 4

Thevenin’s Theorem and Maximum Power Transfer

Introduction

A two-terminal resistive network can be replaced by a voltage source in series with an
equivalent resistor. The value of the voltage source equals the open circuit voltage of the two
terminals under consideration. The value of the equivalent resistor equals the resistance
measured between the open terminals when all the independent sources of the circuit are
deactivated (voltage source shorted and current source opened). This is known as Thevenin’s
theorem. The voltage source is called Thevenin’s voltage (V) and the equivalent resistor,
the Thevenin’s resistance (Rty).

Instead of representing two-terminal resistive network with a voltage source in series with a
resistor, we can represent it with a current source in parallel with a resistor. This is known as
Norton Equivalent Circuit. The value of the current source (Isc) equals the current passing
through a short circuit placed between the two terminals under consideration. In general, the
two equivalent circuits are related by source transformation. Then:

WW—=e a a
Rru

VrH C) Lee <D R

® b * b

Figure 1: Thevenin’s and Norton Equivalent Circuits

The maximum power output to a variable output resistance occurs when the value of the
output resistance equals Thevenin’s resistance.

Rh a
ANV ®
VTH <+> ;RL =R
L J
b

Figure 2: Maximum power output condition

The value of the maximum output power or transferred power is given as,

|3maX :ﬂ
4RTH
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Objectives

1. To construct Thevenin’s equivalent using Workbench.

2.To construct Norton’s equivalent using Workbench.

3.To verify the equivalent obtained in step 1 and 2 using hardwired components.
4.To determine the maximum power transfer condition experimentally.

Materials

Two DC power sources

One Multimeter

Assorted carbon resistors (1 kQ, 10 kQ, 33 kQ, 47 kQ?)
One decade resistor

W\ 1 4 A% W\
10kQ +  1kQ 33kQ

10V CD R, § 47kQ§ CD 5V

o @

Figure 3: Circuit for Thevenin’s and Norton’s equivalent

Procedure

Simulation

1.
2.

Construct the circuit given in Fig. 3 on Multisim Electronics Workbench.

Remove the load resistor R, and connect a Multimeter or voltmeter to read the open
circuit voltage between a and b. Simulate and record the voltage. This is V1 for this
circuit between a and b. Record the value in Table 1.

Place an ammeter (represents a short circuit) between terminals a and b to read the
short circuit current between a and b. Simulate and record the current. This is lgc for
this circuit between a and b. Record the value in Table 1.

Remove the 10-V source. Replace it with a short circuit.
Remove the 5-V source. Replace it with a short circuit.

Connect a Multimeter in the resistance measurement mode (Ohmmeter) between a
and b. Run the simulation and record the value of the resistor. This is Rty in Fig. 1.
Record the value in Table 1.

Hardwired Experiment

Build the circuit of Fig. 3 with hardwired components in the laboratory.

Repeat steps 2 to 6 and find the values of Vty, Isc and Rty experimentally.
Considering the Workbench results as the base, compute the percentage errors.

In the circuit of Fig. 3 connect a variable resistor (R.) between a and b.
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10. Vary Ry between 2.5 kQ and 10.5 kQ in steps of 1 kQ2. Measure the voltage between
aand b (Vy) in each case. Enter your results in Table 2.

Table 1: Simulation and experimental results for Thevenin voltage and resistance

VTH Isc RrtH
Workbench

Hardwired

% Error

Table 2: Experimental results for maximum power transfer
Re

(KQ) 2.5 35 45 55 6.5 7.5 8.5 9.5 10.5
Vi

PL

11. Plot Ry vs. P

P in mwW

R in kQ
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Questions

1. At what value of R, does the maximum value of P, occur in the graph?

2. Does this value of R compare with Rty you obtained experimentally or through
Workbench?

3. Using your results show that the two equivalent circuits are related by source
transformation.

4. Can you give examples for cases were Thevenin’s and Norton’s equivalents are not
related by source transformation?
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Experiment 5
The Oscilloscope and Function Generator

Introduction

The Oscilloscope is one of the most important electronic instruments available for making
circuit measurements. It displays a curve plot of time-varying voltage on the Oscilloscope
screen. The Oscilloscope provided with Multisim Electronics Workbench is a dual trace
Oscilloscope that looks and acts like a real Oscilloscope. A dual trace Oscilloscope allows
the user to display and compare two time-varying voltages at one time.

The controls on the Oscilloscope are as follows:

1. The TIME BASE control adjusts the time scale on the horizontal axis in time per division
when Y/T is selected. When B/A is selected, the horizontal axis no longer represents
time. The horizontal axis now represents the voltage on the channel A input and the
vertical axis represents the voltage on channel B input. When A/B is selected, the
horizontal axis represents the voltage on the channel B input and the vertical axis
represents the voltage on the channel A input. The X POS control determines the
horizontal position where the curve plot begins.

2. The CHANNEL A control adjusts the volts per division on the vertical axis for the
channel A curve plot. The Y-POS control determines the vertical position of the channel
A curve plot relative to the horizontal axis. Selecting AC places a capacitance between
the channel A vertical input and the circuit testing point. Selecting “0” connects channel
A vertical input to ground.

3. The CHANNEL B control adjusts the volts per division of the vertical axis for the
channel B curve plot. The Y-POS determines the vertical position of the channel B curve
plot relative to the horizontal axis. Selecting AC places a capacitance between the channel
B vertical input and the circuit test point. Selecting “0” connects the channel B vertical
input to ground.

4. The trigger settings control the conditions under which a curve plot is triggered (begins to
display). Triggering can be internal (based on one of the input signals) or external (based
on a signal applied to the Oscilloscope external trigger input). With internal triggering
AUTO, A, or B. If A is selected, the curve plot will be triggered by channel A input
signal. If |B is selected, the curve plot will be triggered by channel B input signal. If you
expect a flat input wave shape or you want the curve plot displayed as soon as possible,
select AUTO. The display can be set to start on a positive or negative slope of the input
by selecting the appropriate EDGE selection. The trigger LEVEL control determines the
voltage level of the input signal waveform, in divisions on the vertical axis, before the
waveform will begin to display.

Once a circuit simulation has been activated and a voltage curve plot has been displayed on
the Oscilloscope screen, the Oscilloscope probes can be moved to other test points in the
circuit without running the simulation again. Moving the probes automatically redraws the
voltage curve plot for the new test point. You can also fine tune the settings either during or
after a simulation and the display will be redrawn on the screen automatically. You can
‘pause’ or 'resume’ through the “Analysis Option”. The zoom feature can be used by using
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“Expand”. Normal size will be restored by clicking “Reduce”. You can learn other features
through the help menu.

The Function Generator

The Function Generator is a voltage source that supplies different time-varying voltage
functions. Multisim Electronics Workbench can supply Sine Wave, Square Wave, and
Triangular Wave voltage functions. The wave shape, frequency, amplitude, duty cycle, and
DC offset can be easily changed. It has three voltage output terminals. Connect the COM
terminal to ground symbol. The +ve terminal provides output voltage that is positive with
respect to the COM terminal and the —ve terminal proves an output voltage that is negative
with respect to the COM terminal.

The controls on the Function Generator are as follows:

1. You can select a wave shape by clicking the appropriate wave shape on the top of the
Function Generator.

2. The frequency control allows you to adjust the frequency of the output voltage up to 999
MHz. Click up or down arrow to adjust the frequency, or click the frequency box and
type the desired frequency.

3. The AMPLITUDE control allows you to adjust the amplitude of the output voltage
measured from the reference level (common) to peak level. The peak to peak value is
twice the amplitude setting.

4. The OFFSET control adjusts the DC level of the voltage curve generated by the Function
Generator. An offset of O positions the curve plot along the x-axis with an equal positive
and negative voltage setting. A positive offset raises the curve plot above the x-axis and a
negative offset lowers the curve plot below the x-axis.

Consult the Multisim Electronics Workbench User and Reference manuals for more details
on the Oscilloscope and Function Generator.

Procedure

1. From the instrument panel pull down the Function Generator and Oscilloscope and
connect them as shown in Fig. 1. You can select different colored wires by double
clicking the line and choosing the colors. Select Sine Wave from the Function
Generator. Set frequency to 1 kHz and amplitude to 10V. On the Oscilloscope start with
the Time Base of 0.2ms/div and channel A, B settings of 5V/div.

2. Click the on-off switch to run the analysis. Connect the positive output of the Function

Generator to Oscilloscope channel A input and negative output to channel B input. You
may use red color for Ch. A and blue te for Ch. B, if you wish.
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Function Generator Oscilloscope

O
O

O 0 Q QO o

Fig. 1: The Function Generator and Oscilloscope connection
3. Select the “0” on the Oscilloscope channel B input and run the analysis again.

Question: What change occurred on the Oscilloscope Channel B curve plot? Explain.

4. Change the Oscilloscope channel A to 5 V/div.

Question: What change occurred on the Oscilloscope Channel A curve plot? Explain.

5. Change the Oscilloscope Time Base to 0.1ms/div and run the analysis again.

Question: What change occurred on the Oscilloscope Channel A curve plot? Explain.
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6. Change the Oscilloscope Channel A Y-POS to 1.00 and run the analysis again.

Question: What change occurred on the Oscilloscope Channel A curve plot? Explain.

7. Change the channel A Y-POS back to 0.00 and select DC on channel B input and run the
analysis again.

Question: What change occurred on the Oscilloscope curve plot? Explain.

8. Return the Oscilloscope time base to the settings you started with and select “0” on the
channel B input again. Select the Triangular Wave shape on the Function Generator and
run the analysis again.

Question: What change occurred on the Oscilloscope curve plot? Explain.
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9. Select the Square Wave on the Function Generator and run the analysis again.

Question: What change occurred on the Oscilloscope curve plot? Explain.

10. Change the AMPLITUDE on the Function Generator to 5V and run the analysis again.

Question: What change occurred on the Oscilloscope curve plot? Explain.

11. Change the frequency on the Function Generator to 2 kHz and run the analysis again.

Question: What change occurred on the Oscilloscope curve plot? Explain.
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12. Change the offset on the Function Generator to 3 and run the analysis again.

Question: What change occurred on the Oscilloscope curve plot? Explain.

13. Change the Oscilloscope channel A input to AC and run the analysis again.

Question: What change occurred on the Oscilloscope curve plot? Explain.

14. Click ‘expand’ on the Oscilloscope. Measure the time period (T) of one cycle on the
wave shape.

Question: What was the time period (T) of one cycle on the wave shape?
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Repeat the steps above with the laboratory Function Generator and Oscilloscope and record
your answers in the same order as the Workbench. State any difficulties you encountered in
carrying out the steps.

v(t)=4sin ot
f = 5kHz

Figure 2: Measurement of RMS voltage
19. Connect the hardwired circuit shown in Fig 2. Measure the amplitude (peak value) of
voltage v; using the Oscilloscope and record it.
Vab (peak) (USing Oscilloscope) =
Connect an AC voltmeter between terminals ‘a’ and ‘b’ and record the value
Vap (using AC voltmeter) =

This value is called the RMS value of the voltage wave.

Questions

1. Find the ratio of the two measured values.

V,, (using oscilloscope)
v,, (using voltmeter)

2. Compare the above value with the theoretical (ideal) value and find the percentage error.
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Experiment 6
Sinusoidal AC Analysis

Introduction

The students learned phow to use the Function Generator and Oscilloscope in the previous
experiment. In this experiment they will learn to build and take measurements in AC circuits.
The circuit will be simulated on Multisim Electronics Workbench. Then they will build it
with hardware components and check the accuracy of the measurements compared with the
simulation results. Consider the circuit given in Fig. 1.

a Ry b I c
[ AVAYAY
| 1kQ
C 0.022 pF
v(t)=5sinot
f=10kHz <_> |Cl f L < 12mH
2200 S Rs R,
® A
0 € 1.5k d

Fig. 1: RLC circuit

The equation for sinusoidal current is written in the form,
i(t) = iy sin (0t+0) 1)
where, i(t) is the instantaneous value of current, iy is the peak value, ® is the angular
frequency and 0 is the phase angle of the current with respect to the source voltage. Phase

angle can be measured by using the two traces of a dual trace Oscilloscope and measuring the
time difference between two waveforms, as shown in Fig. 2.

Time shift=1
Phase shift =0 = ot
—> Phase shift =0 =360 (t/T)

time Where T = time period

Fig. 2: Phase angle measurement

The RMS (Root Mean Square) or effective value of the sinusoid is given as in/N2. The real
power dissipated can be computed by using,

P= Vims lims cos 0 2
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1. Measure currents in each branch of the circuit of Fig. 1 using the Oscilloscope
2. Verify KCL for AC circuit
3. Calculate the power dissipated in the resistor.

Materials

Dual trace Oscilloscope

Signal generator

Resistors (1kQ, 1.5kQ, 220Q)
Inductor, 12mH (iron core)

Capacitor, 0.022 uF

Procedure

1. Construct the circuit of Fig. 1. Connect Ch A of the Oscilloscope to the output of signal
generator at point ‘a’. Oscilloscope ground and circuit ground should be the same. Set the
Oscilloscope to AUTO sweep, and use Ch A as the TRIGGER source. Adjust the output
of the signal generator to provide a sinusoidal voltage with an amplitude (peak value) of
5V (10 Vp-p) and frequency of the Function Generator at f=10 kHz.

2. Use Ch B of the Oscilloscope to observe the voltage at point d. This is the voltage across
resistor R,. Measure the peak (half of peak to peak) voltage v, (across R,). Determine
phase angle 0, of voltage v, with respect to generator voltage ‘v’. Calculate the current

L(t)= ”2(@/R2 and enter time domain expression for i_ below.

Table 1: Sinusoidal expressions for voltage (v,) and current (i(t))

V(1)
(amplitude)

02 I (amplitude) = V2 (t)/Rz

(phase, deg)

Expression i (t)

Workbench

Hardwired

3. Move Ch B of the Oscilloscope to observe the voltage at point f. This is the voltage
across Rs. Measure the amplitude v; and phase angle 63 with respect to ‘v(t)’. Calculate

the current ic (v3(t)/R3) and enter time domain expression for ic(t) below.

Table 2: Sinusoidal expressions for voltage (vs(t)) and current (ic(t))

v (amplitude)

0 3 (phase, deg)

ic(t)(amplitude)=vs(t)/R3

Expression ic(t)

Workbench

Hardwired
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a b I c
‘—»
Is
C 0.022 uF
V(t)=5sinot
f=10kHz <_> ,Cl f L 5 12mH
| R, 220Q < Rs R,
o AAAY NN
0 1kQ e 1.5k d
Figure 3:

5. Change the position of resistor R; to that shown in Fig. 3. This change will not affect the
circuit. Connect Ch A to point ‘a’ and Ch B to point ‘e’. Measure amplitude of the
voltage across R; (V1) from Ch B. Determine phase angle 0; of voltage v;(t)with respect

to generator voltage ‘vi(t)’. Calculate the current 13:11=V1/R1 and enter time domain
expression for i(t) below.

Table 3: Sinusoidal expressions for voltage vi(t) and current i (t)

vi(t)(@amplitude) | 61 (phase, deg) | iL(t)(@mplitude)=vi(t)/R; | Expression i(t)

Workbench

Hardwired

Questions

1. Convert the measured values of currents ig, i and ic obtained in steps 3-5 into phasor
form (example, 1=5230°A). Compare these values with the ones obtained through
simulation.

Hardwired Experimental VValues Simulation Values
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2. Use complex algebra to show that the data in step 1 (above) satisfies Kirchhoff’s current
law.
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Experiment 7
Three Phase Circuits

Introduction

Three phase circuits or system are made of three phase source, three phase feeder and three
phase load. The three phase loads are connected in why (Y) or delta A shape. The line (L) and
phase (P) quantities of a balanced three phase circuits are related to each other as follows.

In a Y-connection, the line and the phase quantities are related by:

Vp= VA3 (1)
lp=I¢ )
Whereas the relationships for a A-connection are
lp=1./N3 (3)
Vp=VL 4)
The real and reactive powers for a 3 phase circuit (either Y or A connection) are given as
P=\3 V_I,_cos (0) (5)
Q=V3 V_ I_sin (0) (6)
Where 6 is the power factor angle of the load
0 = tan*(Q/ P) (7)
PF=cos (0) (8)

Equation (7) and (8) can be used also to calculate the per factor for every phase

Objectives

1. Voltages and currents measurement in the three-phase circuits.
2. Power measurement and power factor determination in three-phase circuits.

Materials
1 Variable AC power supply 0-400V.
1 Resistive load bank.
1 Inductive load bank.
1 Capacitive load.
1 Set of 30 safety connectors, blue, black, red
1 Set of 10 safety connectors, green/yellow.

1 Digital multi meter.
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Figure 1 Phase resistance ) ) ) _
Figure 2 Phase internal series resistance measurement
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Figure 3 Y-Connected Resistive Inductive Load
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Figure 4 Y-Connected Resistive Capacitive Load
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Procedure

1.

For preliminary measurements use the digital Multimeter to measure each phase
resistance of the resistive load bank as per figure 1 while the resistance control
position is at (40%) then enter each phase resistance value in Table 1. Do not change
the position of the resistance knob through the rest of the experiment.

Repeat the phase measurement for the inductive load bank (L=0.2H, 0.65A) internal
series resistance for each phase as per figure 2 and enter the values in Table 2.

Table 1: Load Resistance measurements

Resistance control
Position (%)

(40%)

Loadl1(Q) Load2(Q) Load2(Q)

Table 2: Inductance internal series resistances measurements

Inductance (H),

Current Rating (A) Load1(€2) Load2(€2) Load2(Q)
0.2H,0.65 A
Simulation
3. Build circuit shown in Fig. 3 using Multisim Electronics Workbench.
4. Simulate the three phase Y connected voltage source and apply 200 V line to neutral.

Use the resistance values recorded in table 1 and table 2 and indicated value to
estimate the power factor for each phase.

Connect the ammeters and voltmeters at appropriate positions to measure voltages
and currents, real and reactive powers then enter the simulation data shown in Table 3
and table 4.

Repeat steps 3 to 6 for the circuit given in Fig. 4 then enter the simulation data values
in Table 5 and table 6.

Hardwired Experiment

8. Build the circuit of Fig. 3 with the hardwired components. Take the measurements of

voltages, currents, power factor (from step 5) real power, reactive power and
frequency then record them in Table 3 and table 4. Considering the Workbench results
as the base, compute the percentage errors.

Build the circuit of Fig. 4 with the hardwired components. Take the measurements of
voltages, currents, power factor (from step 7) real power, reactive power and
frequency measurements then record them in Table 5 and table 6. Considering the
Workbench results as the base, compute the percentage errors.

Note: (PF: Power Factor and FR: Power Frequency)
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Table 3: Simulation and experimental results for Fig. 3

Variable I I lis | Vun | Vien | Visn | Vue | Vias | Vsu

Workbench

Hardwired

% Error

Table 4: Simulation and experimental results for Fig. 3

Variable | Puu | Pz | Pis | Pror | Qu | Q2 | Qus | Qror | PF | FR

Workbench

Hardwired

% Error

Table 5: Simulation and experimental results for Fig. 4

Variable IL1 I2 lis | Vun | Vien | Visn | Ve | Viaes | Visu

Workbench

Hardwired

% Error

Table 6: Simulation and experimental results for Fig. 4

Variable PLa PLo Pis | Pror | Qu | Qu | Qu | Qror | PF FR

Workbench

Hardwired

% Error

Questions

1. Compare the results obtained with Workbench with those from the hardware circuit, and
comment on the error obtained between hardwired and Workbench results of each case.
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2. What is the relation between the line voltage and the corresponding phase voltage based
on the Multisim workbench results? Is it confirmed by the hardwired results?

3. Do we get similar relation between phase and line current if the load is A connected?

4. In a balanced system, all phase voltages have the same magnitude, what makes the
difference between two consecutive voltages higher 170% of the phase voltage?

5. Do reactive powers in Figure 3 and Figure 4 circuit have the same direction? Why?

6. Does the value of the capacitance have any impact on the load voltage magnitude and
phase? Explain.
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Experiment 8
Transient Circuit Analysis

Introduction

For electrical circuits such as the RC circuit of Fig. 1, the total step response (sum of forced
“steady-state” response and “transient” natural response) can be obtained by solving the 1%
order differential equation describing the circuit. When there is no initial charge across the
capacitor, the voltage V; (t) fort> 0 is shown to be given by:

t

RC

Ve(®) = V(e ™) )

For the 2" order series RLC circuit shown in Fig.2, the total step response is also given by
the sum of the forced and natural response, where the latter can be over-damped, under-
damped or critically damped depending on whether the characteristic roots S;, are real,
complex conjugates, or double roots. With a=R/2L and w,*=1/LC, we have:

Si» =—ai4fa2—woz )

The characteristic roots are real (negative) for o > w,, complex conjugates for o < w,, or
double for a = wy. The different forms of V. (¢t) (for t > 0) are respectively given by

J A 1
Ve (t)=V; +Be*Cosw,t+B e Sin eyt

() pe e

where V', is the final forced response of V- (t)

t=0 =g *t YR — + Vi -
R R I
+ -_—— +
p— C <v v C) T A -
vV — ¢ = \ f] C ™
Figure 1: RC series circuit Figure 2: Series RLC circuit
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Objectives

The experiment covers the analysis of the transient step response of 1% and 2" order circuits.
The experiment is based on Multisim Workbench simulation and verification with hardware
measurements and real components. The main objectives are:

1. To perform transient analysis of a 1% order RC circuit
2. To perform transient analysis of a 2" order RLC circuit

Part I. Transient Analysis of RC Circuit

Materials

Function Generator
Oscilloscope

22nF Capacitor
3kQ Resistor

Procedure
Workbench Simulation

1. Build the circuit of Fig. 1 in Multisim Electronics Workbench. Note node numbers
2. Run the Transient Analysis. The procedure is as follows:
a. Select Simulate from the Main Menu
b. Select Analysis
c. Select Transient Analysis
d. Select Analysis Parameters
e Initial Conditions: Set to zero
e Starttime:0s End time: 0.5 ms
e. Select Output Variables
Select node 2 (left box), this is the node for the capacitor
Select plot during simulation (right box)
f. Select Simulate
3. Observe the wave shape. Using the cursor tool, record the results and enter the data in
Table 1. Plot V; vs. time on the graph provided.
Hardware Experiment
4. Build the circuit given in Fig. 1 with the hardware components. The voltage source
should be drawn from the Function Generator.

5. Set the Function Generator to produce a square wave signal with amplitude 5V and
frequency 1 KHz. This represents a repetitive (periodic) step voltage input.
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6. Apply the input voltage to Channel A of the Oscilloscope, and the capacitor voltage to
Channel B. Adjust the amplitude scale to 5V/div and time base 0.1ms/div to get a full-
screen display (showing only 1 period of the square wave).

Read the values of the output voltage V¢ and record the data in Table 1.

Plot the voltage response on the same graph paper as the simulation results.

Table 1: V¢ Transient response of RC circuit

Time (ms) 0 005 | 01 0.15 02 | 025 | 03 | 035 | 04 | 05

V. (Simulation)

V. (Measurement)

Figure 3: Simulated and Measured Transient Voltage Responses

time in seconds
Questions

1. What is the theoretical value of the time constant t of the circuit in Fig. 1?

2. Explain how to calculate the time constant from the Vc vs. time curves
(simulation and hardware). Comment on any difference between them.
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3. If you apply a square wave input with frequency 1MHz, explain whether this
is suitable for measuring the time constant of the circuit and why?

Part I1: Transient Analysis of RLC Circuit

Materials

Function Generator
Oscilloscope

22nF Capacitor

12mH Inductor

2200 Resistor, 10kQ2 Resistor

Procedure
Workbench Simulation

1. Build the circuit of Fig. 2 in Multisim Electronics Workbench. Use 220Q2 resistor.
2. Run the Transient Analysis following the same procedure as in Part I.
3. Observe and record the V¢ waveform. Enter the data in Table 2. Plot V¢ vs. time
on the graph provided in Fig. 4.
Hardware Experiment
4. Build the circuit of Fig. 2 with the C & L components and the 2202 resistor. The
voltage source is applied from the Function Generator.

5. Set the Function Generator to produce a square wave signal with amplitude 5V and
frequency 1 kHz.
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6. Apply the input voltage to Channel A of the Oscilloscope, and the capacitor voltage to
Channel B. Adjust the scale and time base to get a full-screen display

7. Read the values of the output voltage V¢ and record the data in Table 2.
8. Plot the voltage response on the same graph paper as the simulation results.

9. Change the resistor to 10KQ value. Notice the impact on the transient response.

Table 2: V¢ Transient response of RLC circuit

Time (ms) 0 005 | 01 0.15 02 | 025 | 03 | 035 | 04 | 05

V. (Simulation)

V. (Measurement)

Figure 4: Simulated and Measured Transient Voltage Responses

time in seconds
Questions

1. What is the type of the transient response? What are the theoretical values
of the damping factor o and the oscillation frequency wq?
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2. Using the measured V. values, estimate these factors directly from the
waveform plots. Comment on any difference between the values.

3. When the resistor is set to 10kQ, what is the type of the transient
response? Explain why?
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Experiment 9
Transformer Circuit

Introduction

The principal purpose of a transformer is to convert AC power at one voltage level to AC
power of the same frequency at another voltage level. It is made of two winding and a
magnetic core. Both windings are linked by magnetic flux through a magnetic core. The
transformer has Np turns at the input or primary side and Ns turns at its output or secondary
winding. The relationship between the voltage Vp applied to the primary side of the
transformer and the voltage Vp produced on the secondary side is

Vp/ Vs: Np/ Ns (l)

Np/ Ns =a (2)
Where a is defined as the turns ratio of the transformer. The relationship of the current Ip

flowing in the primary side of the transformer and the current Is flowing out of the secondary
side of the transformer is

|p/ |s =1/a (3)
The real power PP supplied to the transformer by the primary circuit is given by
Pp = Vp Ipcos (0p) 4

Where 0, is the angle between the primary voltage and the primary current. The real power
Ps supplied by the transformer secondary circuit to its load is given by

Ps = Vs Iscos (63) (5)

Where 05 is the angle between the secondary voltage and the secondary current.

Objectives

1. To verify the voltages and currents transformer ratio.
2. To evaluate the Power behavior for loaded single phase transformer.

Materials
1 Variable AC power supply 0-400V.
1 Single-phase transformer. (Np = 847, Ns = 456, N = 456)
1 Resistive load bank.
1 Inductive load bank.
1 Capacitive load .
1 Set of 30 safety connectors, blue, black, red
1 Set of 10 safety connectors, green/yellow.
2 Digital Multi meters.
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AC Source Transformer
11 2.1
L N s <
&)
3-Phase
Variable L2¢ 2.2

Supply <>
0-400V \4
2.5A L g 31
N 3.2
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Figure 1 No load test voltage measurements

AC Source Transformer Resistive Load
11 21
d (A) .
N4
3-Phase
Variable Lo
supply ()
0-400V \
25A Lo
" 12
. )

Figure 2 Resistive load voltage, current and power measurements

AC Source Transformer Resistive Load Inductive Load

L @ 11 21
= g =

3-Phase \4
Variable L2 2
Figure 3 Inductive load voltage, current and power measurement

.2
Supply C)
0-400V v
2.5A L8 31 -
§ ®
N 12 -

G

Procedure

Calculation and Initial Measurements

1. Consider the circuit shown in Fig. 1 then fixe the source voltage at 224 V line to
neutral.

2. Place the ammeter and voltmeters at appropriate position in Fig. 1 circuit. Calculate
the voltages, current and the apparent power then enter the calculated data in Table 1.

3. While the resistive load bank is separated from Fig. 2 circuit, fixe its control knob at
40% then measure the per phase load resistance using the Multimeter.
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4. Calculate the voltages, currents and powers for the connected Fig. 2 circuit then enter
the data in Table 2.

5. While the inductive part of the load is separated from Fig. 3 circuit, measure the per
phase internal series resistance of the inductive load using the Multimeter. Choose the
per phase inductance 1.2 Henry.

6. Calculate the voltages, currents and powers for the connected Fig. 3 circuit and enter
the obtained data in Table 3

Hardwired Experiment

7. Build the circuit of Fig. 1 with the hardwired components. Take the measurements of
voltages, currents, and record them in Table 1. Considering the calculated results as
the base, compute the percentage errors.

8. Build the circuit of Fig. 2 with the hardwired components control knob at 40%).
Take the measurements of voltages, currents and powers then record them in Table 2.
Considering the calculated results as the base, compute the percentage errors.

9. Build the circuit of Fig. 3 with the hardwired components (control knob at 40%o).
Take the measurements of voltages, currents and powers then record them in Table 3.
Considering the calculated results as the base, compute the percentage errors

Table 1: Simulation and experimental results for Fig. 1

Quantity Is Vp Sp Vs

Calculated

Hardwired

% Error

Table 2: Simulation and experimental results for Fig. 2

Quantity Vp |p Pp QP VS IS PS QS

Calculated

Hardwired

% Error

Table 3: Simulation and experimental results for Fig. 3

Quantity Vp ||:> Pp QP VS IS PS QS

Calculated

Hardwired

% Error

53|Page




EE-213 Lab Manual Electric Circuits

Questions

1. Compare the calculated results with those obtained from the hardware circuit, and
comment on the error obtained between hardwired and calculated results of each case.

2. Isrelation (2) verified with relation (1) in figure 1 circuit?

3. 1sSp=Sg? Why’) (Sp:Vp*|p and SSZV5*|S)

4. Why do we have primary current in the circuit of figure 1 although there is no load at the
secondary side of the transformer?

5. What is the reason behind V; of circuit in figure 2 being lower then V of circuit in figure
1?
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6. What is the nature of the current Is in the circuit of figure 3? Is it in favor of the voltage
support?

7. Physically! what causes the consumption of Qp and Qs in the circuit in figure 3?
Explain?
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Experiment 10
Frequency Selective Circuits

Introduction

Frequency selective circuits exhibit a behavior that depends on the frequency of the applied
signals. Filters (and other circuits such as resonant circuits) are typical examples of frequency
selective circuits, and have many numerous applications in electrical engineering. In this
experiment, we study examples of low-pass and band-pass filters.

v (D C——V,

Figure 1: RC Low-Pass filter circuit

For the RC circuit example shown in Fig. 1, the transfer function H(s)=V,(s)/Vi(s) is easily

obtained by VDR. The evaluation of its magnitude and phase (for s=jw) gives:
1 i
. 0 jow)=—tan"lwRC 1)
‘H ( Jw)‘zgRC; ( )

2
2. (1
o +{ - Cj
This is a low-pass filter with half-power (3dB) cutoff frequency m.=1/RC.

On the other hand, for the RLC circuit of Fig.2 (where the output is taken across R), the
resulting transfer function will have the following magnitude and phase:

H(jo)= ——L o(joj-s0 | 71| @
2 ——w
B :
LC L

The circuit frequency response is that of a band-pass filter with center frequency (in rd/s):
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1
Wy = /LC 3)

and the 3dB (half-power) cutoff frequencies are given (in rd/s) by:
w g (]

=20 20) Flie

2
_R,[R| 1] ®
“2=L " [ZL} +[Lc]

Objectives

The experiment deals with the steady-state analysis of frequency selective filter circuits. The
experiment is based on Multisim Workbench simulation and hardware measurements. The
main objectives are:

1. To perform AC frequency response analysis of a low-pass RC filter circuit
2. To perform AC frequency response analysis of a band-pass RLC filter circuit

Part I: Frequency Response of Low-pass RC Filter Circuit

Materials

Function Generator
Oscilloscope

22nF Capacitor
1kQ2 Resistor

Procedure
Workbench Simulation

Build the circuit of Fig. 1 in Multisim Electronics Workbench.
Select Options/Preferences, to show node numbers

Select Simulate from the Main Menu

Select Analysis/AC Analysis

o > w0 e

Select Analysis Parameters
a. Start frequency: 1Hz
b. Stop frequency: 100kHz
c. Sweep type: decade
d. Number of pts/dec: 5
e. Vertical scale: linear
6. Select Output Variables
a. Select node 2 (left box) for the capacitor voltage
b. Select plot during simulation (right box)
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7. Select Simulate

8. Observe the filter frequency response. Using the cursor tool, read the coordinates of
the points on the plot. In particular, read the values at the half-power cutoff frequency

9. Fill Table 1, and plot the filter magnitude and phase response on the graph provided.
Hardware Experiment
10. Build the circuit given in Fig. 1 with the hardware components. The voltage source is

applied from the Function Generator.

11. Set the Function Generator to produce a sine wave signal with fixed 1V amplitude
(the frequency will be changed from 1 to 100 kHz).

12. Apply the input voltage to Channel A of the Oscilloscope, and the capacitor voltage to
Channel B. The display should be set to facilitate reading the output voltage gain and
phase shift with respect to the input.

13. Change the input frequency in small steps, taking a few points per decade. Pay
attention to take a measurement at the cutoff frequency.

14. Read the values of the output voltage magnitude and phase (w.r.t the input voltage)
and record the data in Table 1. Plot the circuit magnitude response and phase response
on the same graph paper as the simulation results.

15. Change the input waveform shape to square wave type, with a 5 kHz frequency.
Observe and record the output signal.

Table 1: Frequency response of RC LPF

Freq (Hz)

Mag (Vo)

Phase(V,)

Figure 3A: RC LPF Frequency Response

Magnitude

Frequency

Figure 3B: RC LPF Frequency Response
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Phase
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Frequency

Questions

1. From the plotted graphs, what is the filter type? What it the measured 3dB
cutoff frequency (in Hz)? Compare it to the theoretical value.

2. Explain the reason for your observations with the square wave input in Step 9.

3. If the capacitor is replaced with a 10mH inductor, explain qualitatively the
impact on the filter type and its characteristics
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Part Il: Frequency Response of Band-pass RLC Filter Circuit

Materials

Function Generator
Oscilloscope

5nF Capacitor

12mH Inductor

1kQ2 Resistor, 220Q2 Resistor

Procedure

Workbench Simulation

1.
2.

Build the circuit of Fig. 2 in Multisim Workbench (use the 1k resistor first).

Run the frequency sweep analysis following the same procedure as in Part I. Use the
cursor to mark the values for cutoff frequencies.

Observe and record the circuit magnitude and phase frequency response. Enter the data in
Table 2. Plot the magnitude and phase on the graph provided in Fig. 4.

Change the resistor to 220Q, observe and record the impact on the response.

Hardware Experiment

5.

Build the circuit of Fig. 2 with the hardwired R, L & C components. The voltage source is
applied from the Function Generator.

Set the Function Generator to produce a sine wave signal with 1V fixed amplitude (the
frequency will be varied from 10Hz to100kHz).

Apply the input voltage to Channel A of the Oscilloscope, and the resistor voltage to
Channel B.

Change the frequency in small steps, taking a few points per decade. Make sure to take
measurements at the cutoff frequencies. Record the values of the output voltage
magnitude and phase (with respect to the input voltage) in Table 2.

Plot the circuit magnitude and phase responses on the same graph paper as the simulation
results.

Table 2: Frequency response of RLC BPF

Freq (kHz)

Mag(Vo)

Phase(V,)
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Figure 4. RLC BPF Frequency Response
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Questions
1. Comment on the frequency response type?

2. For each of the two resistors, specify the values of the half-power (3dB) cutoff
edge frequencies (in Hz)? Discuss and compare with theoretical values
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3. What are the bandwidth and quality factor (for both resistors)?

4. Comment of the resonance behavior of this circuit (for both resistors)

5. If the output is taken across L&C (together), explain qualitatively the type of
filter in this case, and why?
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Experiment 11
Two-Port Networks

Introduction

For many electrical systems (or networks), focusing on the input/output terminals can
provide convenient models for circuit analysis without worrying about the internal details.
Often, a signal is fed into input terminals, processed then extracted at the other output
terminals. There are four variables of interest in this case, as shown in Fig.1.

. i
I1 2

—_— <
® O E—
+ . +
Input Linear Output
Port W1 Network V2. Port
_ . _

Figure 1: Two-port circuit model.

There are six groups of two-port circuit parameters (e.g., the impedance z-parameters,
admittance y-parameters, hybrid h-parameters, etc) that can be used to relate the input/output
voltage & current variables. Any set of parameters can be derived from the other ones. In this
lab, we consider the case of (impedance) z-parameters.

The z-parameters are defined by:

Vl =Z11I1_i_212l2 (1)
V2 = Zlel + ZZZIZ

These parameters can be measured by the following tests (based on open-circuit input port
condition, and open-circuit output port condition):

Objectives:

The experiment is based on Workbench simulation and hardware measurements. The main
objectives are:

1. To perform z-parameters characterization of a given two-port circuit
2. To use the z-parameters model for analysis of a loaded two-port circuit

63|Page



EE-213 Lab Manual Electric Circuits

Part |I: Z-Parameters Characterization

Materials

Voltage Source
Multimeter
2200, 1kQ Resistors

Procedure
AN
! 10 kQ L
—— NN NN < o
+ 3kQ 3kQ +
Vi 1kQ V
. o

Figure 2: Two-Port Circuit Diagram

Workbench Simulation

1. Build the circuit of Fig. 2 in Multisim Electronics Workbench.

2. Apply a DC voltage test source to the input port with the output port open. Use a
voltmeter and ammeter to read the values of the voltages and currents necessary to
compute Z3; and Z,;1. Observe the proper polarity of the currents.

3. Repeat a similar procedure with a DC voltage test source applied to the output port
with the input port open. Use a voltmeter and ammeter to read the voltage and current
values, and derive the parameters Zy, and Z;5.

4. Record the values of the Z-parameters in Table 1.

Hardware Experiment

Build the circuit given in Fig. 2 with the hardware components.

Follow identical steps to (2) and (3) above by applying a DC test voltage to the input
and output ports alternatively, and measuring the relevant voltages and currents.
Again, pay attention to the direction (and sign) of the currents

7. Compute and record the Z-parameters based on hardware measurements in Table 1.

Table 1: Z-Parameters of Two-Port Circuit

Z-parameters Z Zs, Zy Zy

Simulation

Measurement
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Questions

1. Compare the simulation and hardware measurement results. What would be
the sources of any discrepancies?

2. Explain whether this two-port circuit is reciprocal, and why?

3. Explain whether this two-port circuit is symmetric, and why?

4. Deduce the values of the Y-parameters directly from your results
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Part I1: Analysis of Loaded Two-Port Circuit

Materials
Voltage Source

Voltmeter, Ammeter
Assorted Resistors: 10002, 1kQ, 3kQ2, 10kQ, 1kQ

Procedure

Vs (f) 2-port R.=1kQ

Figure 3: Loaded Two-Port Circuit
Workbench Simulation

1. Build the circuit of Fig. 3 in Multisim Workbench.

2. Run the simulation with a 10V DC voltage source. Insert Multimeters to read the voltage
and current of the load resistance.

Evaluate the voltage gain G,=V,/V; and current gain G;=I,/1,
4. Record your results in Table 2.

Hardware Experiment
5. Build the circuit of Fig. 3 with the hardware components.

6. Follow identical steps to (2) and (3) above by applying a 10V DC voltage to the input
side. Use voltmeter and ammeter to read the relevant voltage and current.

7. Evaluate the voltage gain G,=V,/Vs and current gain Gi=I,/I;
8. Record the results in Table 2.

Table 2: Voltage and Current Gains

Load Variables G, Gi

Simulation

Measurement
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Questions
1. Based on the Z-parameters obtained in Part |, derive the expressions for

the voltage and current gains G, and G;
(Hint: write KVL equations for the input and output loops, in addition to

the Z-parameters equations)

2. Derive the equivalent Thevenin source model as seen by the load
resistance

3. Comment on the usefulness of the Z-parameters (and other types of
parameters) for analyzing circuits such as that of Fig. 2
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Appendix |

EE213 Design Experiment Sample

1. Analysis and Tuning of a Band-Reject Filter

Part 1: Theoretical Analysis
Consider the circuit given in the figure.

a)

b)

c)
d)

C @ O' """ :
L
>
2R Ry
o ® O --enest

Figure 1: BRF Circuit
Show by qualitative analysis that the circuit is a band-reject filter. What is the rejected
frequency?
Derive the voltage transfer function and validate your answer to (a)
Derive the expressions of the cutoff corner frequencies
Derive the expressions of the bandwidth and quality factor

Part 2: Multisim Workbench Simulation

a)
b)

c)
d)

Build the circuit in Multisim Workbench

Choose the components such that the reject frequency band is centered at 10kHz and
the quality factor is at least 5

Verify the proper operation of your design by plotting the filter frequency response

Investigate the impact of connecting a load resistor to the filter. Discuss and explain

your results

Part 3: Experimental Testing

a)
b)

c)
d)

Build the circuit with hardware components

Use the function generator and oscilloscope to test the filter design you obtained in
Part 2

Investigate experimentally the impact of a load resistor (test different values) on the
filter reject frequency and selectivity

Discuss your results and draw relevant conclusions
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EE213 Design Experiment Sample

2. Analyzing a Factory and Designing an Expansion

A factory located in the industrial area is planning for an expansion. As an engineer you have
been assigned to perform all of the required analysis and design calculations for this
expansion. The circuit given below represents a circuit model of the devices in the factory
before the expansion.

a b ™
My My
® a3 10 ® 3
20V iz i 30 15V
——4 n — M o

Figure 1: Circuit Model of the old factory

Part 1: Required analysis of the existing factory

a. Calculate the currents i; and i».

b. Calculate the power of each source in the circuit.

c. Calculate the voltage Vg, of the factory before the expansion.

d. Build the circuit in Multisim Workbench verify your calculations in a, b and ¢
above

Part 2: Required design calculations for the new expansion

Knowing that the devices of the new expansion will be connected between terminals a and b,
design the elements of a model representing the new expansion to the factory if you are given
that after the expansion the voltage Vy, is to be 20V.

a. Build the complete circuit in Multisim Workbench and verify the proper
operation of your design by measuring the voltage Vgp.

b. Build the circuit with hardware components and verify the proper operation of
your design by measuring the voltage Vgp.

c.  What will be the new values of the currents i, and i,.
d. Discuss your results and draw relevant conclusions
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EE213 Design Experiment Sample

3. Design a Scheme to Improving Load Power Factor

The utility company is supplying a static three phase Y connected load at 200 V line to

neutral. Each phase is composed an impedance of 350 Q in series with 1.2 H inductor.

Resistive Inductive Load

AC Source I
Ll]—{FLmE
3-Phase 1 - ]

Variable L:#{ise]

Supply

0-400v

354 La#-fuse) =l =

. 555

f o]

Figure 1 The Load Circuit Connection to Utility
The load nature presents a costly and unacceptable low lagging power factor to the power
company. The load power factor has to be improved to 0.8 lagging or higher. It is required
to evaluate the actual power factor and then to design a scheme to be installed for improving
the load power factor. The required design steps has to conducted then the hardwire design

has to be installed and tested. Practical results are required.
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Appendix |1

Resistor Conversion Table

4-Band-Code
1 1 1 | [ 1
2%, 9%, 10% | | : SE0kCE 5%

COLOR 1st BAMD 2nd BAMND 3rd B AMD MULTIPLIER TOLERANCE

0.1%, 0.25%, 0.9%, 1% 2370+ 1%
I 1 [ 1 [ ]
5-Band-Code

Capacitor Conversion Table

uf.microFarads nf.nanoFarads pf.picoFarads | Multiplier used
=10° Farads =10° Farads =10"2Farads | === 0T

0.000001 uf= 0.001nf= 1pf (1)
0.00001uf= 0.01nf= 10pf (10}
0.0001uf= 0.1nf= 100pf (101 )
0.001uf= 1nf= 1000pf (102 )
0.01uf= 10nf= 10000pf (103 )

0.1uf= 100nf= 100000pf (104 )

1.uf= 1000nf= 1000000pf {105 )

100uf 100000nf= 10000000pf _—
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Appendix 111

LABORATORY REGULATIONS AND SAFETY RULES

The following regulations and safety rules must be observed in all laboratory locations.

1.

10.

11.

12.

13.

14.
15.

16.

It is the duty of all concerned who use any electrical laboratory to take all
reasonable steps to safeguard the HEALTH and SAFETY of themselves and all
other users and visitors.

Be sure that all equipments are properly working before using for laboratory
exercises. Any defective equipment must be reported immediately to the lab
instructors or lab technical staff.

Students are allowed to use only the equipment provided in the experiment
manual or equipment used for senior project laboratory.

Power supply terminals connected to any circuit are only energized in the
presence of the instructor or lab staff.

Students should keep a safe distance from the circuit breakers, electric circuits
or any moving parts during the experiment.

Avoid any body contact between energized circuits and ground.

Switch off equipments and disconnect power supplies from the circuit before
leaving the laboratory.

Observe cleanliness and proper laboratory housekeeping of the equipment and
other related accessories.

Wear the proper clothes and safety gloves or goggles required in working areas
involving fabrications of printed circuit boards, chemical process control
systems, antenna communication equipment and laser facility laboratories.
Double check your circuit connections specifically in handling electrical power
machines, AC motors and generators before switching “ON” the power supply.
Make sure that the last connection to be made in your circuit is the power supply
and first thing to be disconnected is also the power supply.

Equipment should not be removed or transferred to any location without
permission from the laboratory staff.

Software installation in any computer laboratory is not allowed without the
permission from the laboratory staff.

Computer games are strictly prohibited in the computer laboratory.

Students are not allowed to use any equipment without proper orientation and
actual hands-on equipment operation.

Smoking, eating and drinking in the laboratory are prohibited.

The above rules and regulations are necessary precautions in the electrical laboratory to
safeguard the students, laboratory staff, the equipments and other laboratory users.
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